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Tanusitvanyok hasznalata
Microsoft Office 2010 alkalmazasbol

Windows operacios rendszeren tanusitvanytarban, PFX fajlban, vagy
kriptografia eszk6zokon talalhatoé tanusitvanyok esetén
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2. Bevezetd

Ennek a tajékoztatonak az a célja, hogy az elektronikus alairashoz és/vagy titkositishoz
hasznalhaté szoftverek bedllitisa minél zokkend mentesebben megtorténjen, illetve hogy a
hasznalat kénnyen elsajatithaté legyen.

Amennyiben barmilyen kérdése van vagy problémija tamad, Ugyfélszolgalatunk az (40) 22-55-22
telefonszamon, a support@netlock.hu e-mail cimen vagy személyesen a 1101 Budapest, Expo tér
5-7. szam alatt, munkanapokon 9 és 17 6ra kézott készséggel all rendelkezésére.

3. A Microsoft Office 2010-r6i

A Microsoft Office 2010 egy tobb alkalmazast tartalmazé irodai programcsomag, melyek koziil
egyes komponensek rendelkeznek digitalis alairast tamogat6 részekkel.

A csomag digitalis alafrast timogatorészet:
Excel tablazatkezel$

PowerPoint  prezentacié (bemutatd) készitd
Word szovegszerkesztd

Tovabba Word ¢és Excel esetében megjelent az Alairasi mez6 beszarasa funkcié, mely egy
hasznos 4j eszkoz, és melynek hasznalatat szintén targyalja ezen dokumentacio.

4. Opericios rendszer kovetelmények

A tanusitvanyok hasznalatahoz ajanlott minimum operaciés rendszer kévetelmény:
Windows XP SP3

Vista SP1

Windows 7

5. Aktuilis szerviz csomag az SHAZ256 algoritmusu tanusitvany hasznilatihoz

Az SHA256 algoritmusu alairé és titkosité tanusitvanyok kezeléséhez az alabbi frissitésre lehet
szitkség, amennyiben nem naprakész az Office2010.
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6. Formitum korliatozasok

Az Office 2010 lehet6vé teszi, hogy 97-2003 verzidval kompatibilis mentést hajtsunk végre az
alkalmazasbol.

A digitalisan alairt dokumentumokrél egy ilyen fajlformatum valtas soran az alairas lekeril, azt az
4j formatumban mentett fajl esetén djra ala kell irni.

Oftice 2010-ben kompatibilis formaban mentve, és alairva és Office 2003-ban a digitalis alairas
jelzés nem latszik azonban a dokumentum alairt.

Oftice 2003-ban alairva, Office 2010-ben megnyitva az alairas latszik és érvényes a jelzése is.

6.1. A Microsoft Office 2010 alkalmazds tanusitvinykezelése

6.2. Rovid attekintés a tanuisitvany igénylési - és tarolisi megoldisokrol

A tanusitvanyok létrehozasa és tarolasa tobbféleképpen térténhet. Ezek kulonbségeirdl olvashat a
kovetkez6kben, amely hasznos lehet a bedllitishoz. Természetesen a beallitas elvégezhet6 ezen
rovid attekintés elolvasasa nélkil, de amennyiben 4j digitalis alairas hasznald, javasoljuk elolvasni.

6.3. Tanusitviny igénylése Mozilla bongészon keresztiil

A Mozilla bongész8k, levelez6k a tobb operaciés rendszeren hasznalhatésag érdekében a
tanusitvanyokat egy-egy sajat védett taroloban taroljak, melyhez csak az adott, illetve az ezt
megfeleléen kezelni tudo alkalmazas fér hozza, az operaciés rendszer iranyabol nem latszik.

Amikor Mozilla bongészével hoz létre weboldalunkon egy kérelmet, akkor a privat kulcs a
bongészé sajat taraban jon létre, ott tarolodik, és a késébb kiadott tanusitvanyt a Mozilla
boéngészoével az tigyfélment importalas pontjat valasztva helyezi be véglegesen a taroléba, ez utan
lesz az hasznalhato.

Ekkor készithet réla biztonsagi mentést, mely a szabvanyos PKCS#12 (vagy masik nevén PFX)
fajlformatumban jon létre.

Fontos megjegyezni, hogy a bongész6 is védi ezt a kulcsot (Mestetjelszo), amit elsé alkalommal
On allit be, amennyiben ezt a jelszot elfelejti, nincs lehet8ség a késébbiekben sem a tanusitvany
hasznalatara, ezért a bongész6 védelmi jelszavat biztonsagosan tarolja.

Mivel minden egyes Mozilla termék, kilon tanudsitvanytarral rendelkezik, ha masik Mozilla
termékbol kivanja hasznalni tanusitvanyat, arrdl itt mentést kell készitenie, és oda is telepitenie
kell azt.

Fontos! A tanusitvanykérelem beadasa (kulcsgeneralas) és az elkészilt tandsitvany importalasa
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kozotti idészakban, ne telepitse ujra operaciés rendszerét, se bongészgjét, mivel ezzel
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helyreallithatatlanul t6rli a tandsitvanydhoz tartozé privat kulcsot is; e nélkil pedig az
hasznalhatatlan lesz.

6.4. Tanusitviny igénylése Internet Exploreren keresztiil

A Windows operacios rendszer biztosit egy kézponti tandsitvany tarat, amelyet az alkalmazasok,
amelyeket erre felkészitettek, elérhetnek. Ehhez a tarhoz fér hozza a teljesség igénye nélkil a
Microsoft Internet Explorer, az Outlook és Outlook Express programok, illetve a digitalis
alairasra képes Office alkalmazasok is.

Amikor Internet Explorer bongészével hoz létre weboldalunkon egy kérelmet, akkor a privat
kulcs a Windows operaciés rendszer tanusitvanytaraban jon létre, ott tarolodik, és a késébb
kiadott tanudsitvanyt az Internet Explorer boéngészével, az ugyfélmenii importalas pontjat
valasztva helyezi be véglegesen a taroloba, ez utan lesz az hasznalhato.

Ekkor készithet réla biztonsagi mentést, mely a szabvanyos PKCS#12 (vagy masik nevén PFX)
fajlformatumban j6n létre.

Fontos! A tanusitvanykérelem beadasa (kulcsgeneralas) és az kiadott tanusitvany importalasa
kozotti idészakban ne telepitse udjra operacios rendszerét, se bongészéjét, mivel ezzel
helyreallithatatlanul t6rli a tandsitvanyahoz tartozé privat kulcsot is, e nélkil pedig az
hasznalhatatlan lesz.

6.5. Tamisitviny és kulcsok kriptogrifiai eszkézon (kdrtyan, tokenen)

Igen népszer igénylési mod a tanusitvanyok kartyan vagy tokenen valé igénylése, mely az
eszk6z6k és a hozza tartozo PIN kod miatt egy fokkal magasabb biztonsagot is nyujt.

Az ilyen eszkozokben a privat kulcs biztonsagosan tarolédik, az egyes alairasi miveletek kézben
sem kertl ki az eszk6zbdl, hanem az kapja meg a feladatot, és PIN kod kérés utan adja vissza az
eredményt.

Amikor egy ilyen eszkozt hasznal, akkor el6tte természetesen a meghajté (driver) programokat
telepitenie kell a gépre, melyek telepitése soran az eszkéz a Windows tanusitvanytaraval magas
fokon integralédik, tehat Windows tanusitvanytarat hasznalé alkalmazasok (a teljesség igénye
nélkil: a Microsoft Internet Explorer, az Outlook és Outlook Express programok, illetve a
digitalis alairasra képes Office alkalmazasok) r6gton hasznalni tudjak.

Amennyiben az alkalmazas NEM hasznalja a Windows tanusitvany tarat (példaul Mozilla
programok) természetesen meg kell mondani az alkalmazasnak, hogy hogyan éri el az eszkozt.
Ezért bonyolultabb példaul a Mozilla programok beallitasa.

Az ilyen eszk6ézon kiadott tandsitvanyokrél egyébként nem tud PKCS#12 (vagy masik nevén
PFX) mentést csinalni, mert a kartyarol a privat kulcs nem szedhet6 ki.
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6.6. Tanusitvany és kulcsok PKCS#12 (PFX) dllomanyban

Mint az el6bbiekben olvashatta, a PKCS#12 (vagy masik nevén PFX) fajlformatum alapvetéen
biztonsagi mentés, illetve kulcsok és tanusitvanyok egylittes mozgatasa gépek kozott céljara
szolgalhat. Ilyen formdban tanusitvanyt nem tud igényelni, hanem csak létrehozni tudja azokat,
melyeket helyreallitasi céllal egyébként is 1ényeges megtennie.

7. A tanusitvdnyok telepitése

Az el6z6 fejezetekben attekintetteknek megfeleléen, a kovetkezok leirjak, hogyan tudja a
tanusitvanyat beallitani a hasznalathoz.

7.1. Ha a tanusitvdany kdrtydn, tokenen talilhato

Amennyiben tanusitvanyat kriptografiai eszk6zon kapta meg, akkor a kriptografiai eszkoz
telepitési utmutatdja leirja, hogyan importalhaté a tanusitvany a Windows tanusitvanytarba.
Kérjik, hajtsa végre az ott leirtakat.

7.2. Ha a tanusitvidny madr a gépen talilhato

Ha a tanusitvany a tandsitvany igénylését (fokozott biztonsagu tanusitvany esetén) Internet
Explorerbdl intézte, a tandsitvany kiadasi folyamat végén a tanusitvany és a kulcsok
megtalalhatok az On gépén.

Ekkor nincs sziikség a tandsitvany telepitésére, azonban biztonsagi masolatot érdemes
létrehoznia.

7.3. Ha a tanusitvinykérelem beadisa Mozilla béngészon keresztiil tortént

Amennyiben a kérelmet Mozilla bongészon keresztiil adta be, a késébb kiadott tandsitvanyt a
Morzilla béngészovel, a NetlLock tgyfélmeniijébe belépve (itt: Tanusitvanyok mentipont> Kiadott
tanusitvanyok) az importalas pontot valasztva tudja véglegesen Mozilla sajat tandsitvanytaroléjaba
behelyezni, majd ezt importalnia kell, és a Windows tanusitvany tarba telepitenie.

7.3.1. Tanusitviny exportilisa Firefox bongészobol Windows taniusitvanytirba
telepitéshez

A Firefox bongészé az egyik leggyakoribb Mozilla bongész6, ezért a PKCS#12 mentés készitését
ezen mutatjuk be, a tobbi Mozilla termék PKCS#12 mentés készitését az adott termékhez készult
dokumentacié mutatja be.
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1. Inditsa el a Firefox bongészét.

2. Navigiljon el a Tanusitvanyok meniipontig. Eszkoézok > Bedllitaisok > Haladé >
Titkositas ful > Tanusitvanykezel6 gomb (Tools > Options > Advanced > Encryption
fil > Manage certificates gomb).

3. A megjelené ablakban a Sajat tanusitvanyok (Your certificates) fulon valassza ki
mentendd tanusitvanyt, majd nyomja meg a Mentés (Backup) gombot.

4. A kovetkez6 ablakban adja meg a mentés helyét.

5. Ezt kovetéen adja meg Firefox-on belili tanusitvanyvédelmi jelszot. (mestetjelsz6 /
master password) (Ez az elsé tanusitvany export-import el6tt nincs bedllitva, ekkor
kétszer kell begépelnie, és a késébbiek soran ez utan fog rendszeresen érdekl6dni a
Firefox bongészé.)

Ezutan adja meg a .pfx fajl jelszavat, amellyel védeni kivanja, ezt a jelszot jegyezze is fel.

7. A mentés utan tdjékoztatast kap, hogy az sikeresen megtortént, majd nyomjon Ok
gombot az 6sszes ablak bezarodasaig.

A tanusitvany exportalasa ezzel megtortént. Javasolt az exportalt allomanyt a telepités utan, mint
biztonsagi masolatot biztonsagos helyre eltenni.

A kovetkez6 fejezet ismerteti a PKCS#12 allomanyok telepitését.

7.4. PKCS12 (PFX) fajlban talilhato tamisitviny telepitése Windows taniisitvanytdrba

Abban az esetben, ha tanusitvanyat nem kriptografiai eszk6zon szerezte be, és nem Internet
Explorer bongészén keresztil igényelte, akkor az arrdl készilt PKCS#12 (pfx) formatumd
mentett allomany segitségével is tudja tanusitvanyat a Windows tanusitvanytarban beallitani.

A Windows tanusitvanytarba a tanusitvany és kulcs importalasanak folyamata a kovetkezé:

1. Ahhoz, hogy a gépén talalhat6 PKCS#12 allomanyt telepitse, kattintson kétszer az
Intéz6b6l (Explorer) a *.pfx, (*.p12) kiterjesztést fajlra. Ekkor a tanusitvany telepitése
varazslé indul el.

2. Az udvozl6 képernyén nyomja meg a Tovabb (Next) gombot.

3. A masodik képernyén az importalandd fajl nevét latja. Itt nincs semmi teendd, Iépjen

tovibb a Tovabb (Next) gomb x|
segitségével. Jelszo

A biztonsag kedvéért a személyes kulcsat jelszdval lehet védeni,

4. A kovetkezé képernyén adja meg a

PKCS#12 fijlhoz tart6z6 jelszot. Adie meg 2 saemelyes kolcsJelszavst
2117 . ;s ” Jelsza:
Itt allithatja be a tandsitvany erds [
védelmét és kés6bbi
eXpOfté.].hatéSé,gét Javasolj uk v Személyes kulcs erds védelmének engedélyezése, Haengedélyeziests
bedllitast, akkar figyelmeztetést kap minden alkalormmal, amikar egy alkalmazés
mindkét opcidt kipipalni és ezutan hasznda a személyes lulcsot.
a TOVabb (NeXt) gombOt V& kules megjelélés exportélhatdként, Ez lehetdvé teszi a kulcsok biztonsagi
: mentéset &s atvitelst,
megnyornnl.

< Yissza I Tovabb = I Mégse
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5. A kovetkez6 képerny6é megkérdezi, hogy automatikus vagy kézzel t6rténé elhelyezést
kivan a megfelel6 tanusitvanytaroloban. Itt valassza az Automatikus kivalasztast
(Automatically...), majd kattintson a Tovabb (Next) gombra.

6. Az utolsé képernyén kattintson a Befejezés (Finish) gombra.

A tanusitvany telepitése ezzel megtortént.
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Az alabbiakban a dokumentumok alairasat ismertetjiik Word2010-ben.

1. A dokumentum alairasait a Fajl meniib6l valaszhaté Informacié > Dokumentum

r o e rqs rror r r o7 s r ror .
védelem > Digitalis alairas hozzaadasa opci6 kivalasztasaval tudjuk
, .
kezdeményezni..
I ” . .
2. A kovetkez6 ablak jelenik meg:
Mid9-0 QI Dokumentum!
Kezdolap Beszuras Lap elrendezése Hivatkozas Levelezés Korrektura Nézet
= Mentés z
A(z) Dokumentum1 adatai
Mentés masként
(&7 Megnyitas Engedélyek
[ Bezaras Barki megnyithatjs, masolhatja é& médosithatja 2 d
barmely részét.
p——
Informécié -
Legutobbiak Megjelglés véglegesként
Masok értesitése arrol, hogy a dokumentum végleges,
. illetve a dokumentum irasvédetté tétele
Y Titkositas jelszéval hogy tar
A dokumentum megnyitasahoz jelszo szukséges.
Nyomtatas neve
Szerkesztés korldtozasa
Mentés és kiildés Meg szeretné adni, milyen tipusu valtoztatasokat
égezh masok a
Sugoé Engedélyek korlatozasa személyek szerint
Személyek hozzaférésének biztositasa, egyuttal szerkesztési, * rzidi.
) Beallitasok masolasi és nyomtatasi engedélylk megszuntetése
Digitélis aldirs hozzaaddsa
Kilépés A & éoé
digitalis alairas hozzaadasaval.

3. Alairni csak mar mentett dokumentumot lehet, amennyiben ez még nem tértént meg,
az alkalmazas figyelmeztet arra, hogy az alairas el6tt azt menteni kell

Microsoft Word

&

Alairasok hozzdadasahoz digitdlis alirdsokat tdmogatd Formatumban kell mentenie a dokumentumot.
Menti a dokumentumat Word-dokumentumként?
N

) |

I Igen Nem
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4. A megjelené ablakban meg kell adnunk az alairas okat szévegesen, majd a Modositas
gombbal (Change) kivalaszthatjuk a tanusitvanyt. Ha a megfelel6 van kivalasztva, az
Alairas (Sign) gombbal elvégezhet6 az alairas.

Aldirassal készUl efldtni ezt a dokumentumot, Az aldirds a dokumentum
s2dvegében nem lesz [dthatd.
A dokumentum alérdsdnak éfja:

Vélasszakiah i ki it
Tulajdonos: Kidlitd Rvid név
Edkea nS: .. Ke m oS b Nincs

Elkelen nsee...

>

it

ok ][ megse ] [Toniskvény megtekintése ]

5. Amennyiben a szamitégépiinkre kriptografiai eszk6zon tarolt (smart kartya, USB token)
tanusitvany korabban kerilt telepitésre, az operacids rendszer kéri az eszkdz behelyezést,
csatlakoztatasat, majd a PIN kod megadasat.

Aldiras [?][X]
Aléiras létrehozasa...

Please enter the passphrase to complete this
operation.

Pin code: I

Number of tries left: 3

OK Cancel l

6. Az érvényes alairasrol a statusz sorban megjelené piros pecsét ikon tanuskodik. Ez utin
mentve az allomanyt, az alairtként mentédik.

Page: 7 of 90 | Words: 8914 | Hungarian | ﬂ |

8. Alairas utan a dokumentum nem lesz moédosithatd, a pecsét ikora kattintva, az Alairasok
szalagon megtekinthetjiik a dokumentumon taldlhaté alairasokat, illetve azok indokat. A
modositashoz az alairast torélnink kell (Alairas eltavolitasa).

9. Ha egy dokumentumot t6bb tanusitvannyal kivanunk alairni, ez megtehet a fenti médon,
az Osszes tanusitvanyt egyenként kivalasztva.
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9. Dokumentumok aldirdsinak megtekintése, ellendrzése

Alairt dokumentumon a megnyitasa utan a kovetkezé helyen latszik, hogy alairt:

1. A statuszsorban talalhat6 pecsétre kattintva ellendrizhetd az alairas:

Page:70f90 | Words:8914 | Hungarian | @ |

- 8Xx
Alafras utan a dokumentum nem lesz moddosithatd, a pecsét
ikora kattintva az Alairasok szalagon megtekinthetjik a A #wesss
dokumentumon taldlhat6 aldfrdsokat, illetve azok indokdt s« ﬁ:‘:.:;es
(chhez a legérdulé meniibél az Alairdas részleteire kell Szerkesatés
kattintani). A moédositashoz az alairast torélnink kell (Alairas 5 it —
eltavolitasa). = E"T_#EZZOSI-

2 Ujbéli aldiras...
Alairas részletei,.
Alairas beallitasa..,

Alairas eltavolitasa
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10. Aliirasi sor hasznalata

Az Alairasi mez6 (Signature line) koncepcidja az, hogy a felhasznilé egy dokumentumba ilyet
elhelyezve, az mind nyomtatisban megfeleléen nézzen ki, mind elektronikusan biztositson
lehet6séget az alairas elhelyezésére.

10.1. Aliir4dsi sor beszurdsa dokumentumba

A beszurashoz a Beszuras > Alairasi sor (Insert > Signature line) mentipontot kell kivalasztani.

2| x| A megjelen6 ablakban kell megadnunk az
alairas kilonboz6 tulajdonsagait.

 javasolt aldis, (suggested signer) akic

elvarjuk, hogy a mez6ben alairjon

dokumentacié készitd :) e javasolt alairé beosztasa (title)

e ajavasolt alairé email cime (e-mail address)
warga_v@netodk.hu ) )

e utasitasok az alaironak (instructions)

Amit ide irunk jelenik majd meg az alairast elhelyezdnek. Megjelélheté még két opcio:

e az alair6 megjegyzéseket vehet fel az
Alairas parbeszédpanelen (Allow singer to
add comment...)

Signature Setup

e az alairas datumanak megjelenitése az
alairasi sorban (show sign date...)

Az Ok gomb megnyomasa utan valami ilyesmit kell latnunk:

“3| Signatures v X
|2 Requested signatures:
Varga Viktor

Ezegyszipiszupiszerzddes, melyet+
vagydigitalisan,«+
vagy«ezzelmajdald-kellenedrni.q

- X =
Varga Viktar
dokumentacid készitd ;) " 0

Mint lathat6, az Alairasok panelon is megjelent az elvart alairas.
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10.2. Aldirds elhelyezése az aldirdsi sorba

Figyelem, csak mentett dokumentumra helyezhet6 be az alairas az alairasi sorba!

Az alairas elhelyezése egy ilyen mez6ébe gyerekjaték, csupan duplan kattintanunk kell a mezére, és
ekkor megjelenik egy ehhez hasonl6 ablak.

Sign 2| x|| A felsé dobozban megjelenik az a
szoveg, amit a mez6
létrehozasakor, mint dtmutatét az
alairashoz megadtunk.

Az alatta talalhaté részen KELL
vagy szovegesen megadnunk a
nevinket, vagy kivalasztanunk egy
képet az alafrasunkhoz.

@ See additional information about what you are signing. ..

O ssumscomamsatsssearm, |
reoemsmm—————

Az alsé alairasi cél (purpose) mezé

x Select Image. . csak akkor jelenik meg, ha a mez6

Varga Vikior beszgrz},sa,k(')r a  megjegyzés

dokumentadd készits 1) hozzaf(zési lehet6ség  opciodt
bekapcsoltuk.

Az legalsé alairas mez6ben a
Modositas  (Change)  gombbal
kivalaszthatjuk a tanusitvanyunkat,
illetve megvaltoztathatjuk az ott
éppen lathatét, ha az nem
megfeleld.

A lépések a kovetkezok:

1. A Kép kivalasztasa (Select image) opcidra kattintva tallézzuk ki a hasznalni kivant képet
vagy megadjuk az el6tte 1évé dobozba szovegesen a neviinket.
(Ez lehet akar a beszkennel alairdsunk is, de biztonsagi okokbdl, figyeljink arra, hogy a
felbontasa lehetéség szerint ne legyen tulsagosan j6 minéségt, hiszen szkennelt alairasunk
birtokaban nem elektornikus dokumentumokat azért még meg lehet hamisitani.)

Ha lehet, és van hozzaftzni valonk, toltsiik ki a megjegyzés mezét.

3. Ha nem a megfelel§ tanusitvanyt latjuk alul, valaszzuk ki a Moédositas (Change) gomb
segitségével.

4. Nyomjunk ra az Alairas (Sign) gombra.

5. Ez utan tanusitvanyunknak megfeleléen a rendszer kérheti kartyan behelyezését és PIN

kod megadasat, vagy csak egyszerden elvégzi az alafrast. Az alairds utan a dokumentumot
automatikusan lementi, nem kell nekiink Gjra lementeni azt.
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10.3. Példa egy aliirt aliirdsi sorra

Példankban Varga Viktor mindsitett elektronikus alairasaval lattunk el egy révid dokumentumok,
és képként az alairashoz korunk legnagyobb énckesndjének Britney Spearsnek alairdsat
vilaszottuk. (©)

ﬁ
=, Valid signatures:
Varga Viktor 2007.08.27.

Ezegyszipiszupiszerzidés, melyet+
vagydigitalisan,+
vagy«ézzelmajdala-kellenedrni.q

ar o
2007.06.27.

X BtL 3,

Az alairt alairasi sorral rendelkez6 dokumentumon, a megnyitasa utan tobb helyen latszik, hogy
alairt:

A statuszsorban (a képerny6 aljan) talalhatd pecsét:

Page:7 0f90 | Words: 8914 | Hungarian | & |

Alairas utan a dokumentum nem modosithatova valik, a pecsét ikora kattintva az Alairasok
szalagon megtekinthetjik a dokumentumon talalhaté alairasokat, illetve azok indokat. A
moédositishoz az alairast torélnunk kell.
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11. Fiiggelék A — Office 2010 PDF modul beadllitisa szabvinyos PDF zdllominyok
Iétrehozdsihoz

Az alabbiakban az Office 2010 bévitményeként szolgal6 PDF modul bedllitasait taglaljuk,
melynek segitségével szabvanyos formaban jonnek létre az egyes PDF fajlok. Ennck elénye
(tobbek kozott) hogy a példaul a PDFSigno alkalmazassal is ala lehet irni ezeket.

A beépiil6-modul telepité csomagja letSlthetd az alabbi cimek egyikérdl:

Magyar nyelvd Ofﬁce 2007-hez:

3676 42e6-b059-22¢79ed87041

Angol nyelvi Office 2007-hez:
http://www.microsoft.com/downloads/details.aspx?displavlang=en&Family]D=4d951911 -

3e7e-4ae6-b059-22¢79ed87041

A telepitést pozitiv helyesl6 valaszadassal tovabb kell engedni, azt kévetéen az alabbi beallitasokat
szitkséges eszkozolni:

Az Office logora kattintva > Mentés Masként > PDF vagy XPS > fijlnév megadasa > Beallitisok
> 1SO 19005-1-kompatibilitas (PDA/A) > OK > Koézzététel (Mentés)
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Beallitasok

Cldalkarkann &

1 aktudlis oldal
@ 2 kijeldlt beriilet

1 pész ErEl Eddig:
Kizzéteendd
1@ Diokumentum
@ Dokumentum korrekbdrdval
A nern myomtakandd adatokkal egwict
B komvevielzik Ebrehozasanak alapia:
@ cimsorok
@ word kinyvielzék
M &datlap
[V kisegitd dokumentumszerkezeti cimkék
PDF-beallitasak
[/] 150 19005-1 -kompatibilis (PDFjA)
M Eitképes sziveq hasznélata, ha nem dgyazhatdk be a betditipusok:

I Qi | | M&gse

1. 4bra - Office 2007 "PDF vagy XPS" modul beallitasa
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12. Fiiggelék B — Biztonsigi madsolat készitése tanusitvianyairdl és kulcsairol

Ha tanusitvanya fokozott biztonsagt és NEM kriptografiai eszk6zon kapta meg, akkor érdemes a
tanusitvanyar6l PKCS#12 (*.pfx) allomanyban biztonsiagi masolatot késziteni, hiszen a
szamitogép sériilése, illetve Gjratelepitése utan csak ebbdl tudja a tandsitvanyt visszaallitani.

—_

A kulcs és tanusitvany exportalasahoz inditson Internet Explorer bongészot.

2. Navigaljon el a tandsitvanyok mentponthoz. (Eszk6zok > Internet beallitasok >
Tartalom fil > Tanusitvanyok gomb) (Tools > Internet Settings > Content fuil >
Certificates gomb)

3. Valassza ki a Sajat (Personal) lapon a tanusitvanyok kozil az exportalandot, majd nyomja
meg az Export gombot.

4. A megjelend tanusitvany exportald varazslé idvozlé képerny6jén nyomja meg a Tovabb

(Next) gombot. x|
. ” , -, A személyes kulcs exportalasa
5. A kovetkez6 ablakban valassza a privat kulcs Exporcéiatya a személyes kulcsat & andsbusrmyal gyt
exportalasat is (Yes, export the private...), majd
kattintson a Tovabb (Next) gombra. A e A b e
6. A kovetkez6 ablakban a masodik radibgombhoz B R et s
, k ., , h Y k 1 I ,111, b ¥ Igen, a személyss kulcs exportélésat vilasztom
tartozo S$zekClo cerheto csa cL tt allitson € " hem, nem skarom exportlni a személyes kulcsomat

Er6s titkositast (Enable strong protection). Ha
szitksége van arra, hogy a tanusitvannyal egytitt a =
hozza tartozé gyokértanasitvanyt is exportalja,  eportsjformam

akkor jelélje k_i a Minden tanﬁsl’tvé,ny exporta',lésa A tanudsitvanyok kdbbféle fajlformatumban exportalhatdk.

opciot (Include all certificates...) is. Ha a privat

“alassza ki a hasznalandd Formatumat:

kulcsot tor6lni akarja az exportalas utan errdl a £ DER et i 5030 R
géprol, akkor jelolje be a privat kules torlése o skt S0 O
. ., . £ Titkositott dzenetek seintaxsanak szabvanya - PKES #£7 tamistvanyok (%, P7E]
(Delete the Perate...) OpCIOt 18. I Minden tantsit Ay belefoalalésa & bantsityAnylncha
. ” . 7 ' Személyes informacidcsere - PKCS #12 (% PFX)
7' '.A kOVCtkCZO ablakban ad]a meg ketszer .aZt a I™ Minden kandsitvany belefoglaldsa a kandsitvanylancha
jelszot, amelyet szeretne a fajlnak adni. Ez ¥ Ex6s védslem (csaki E 5.0, NT 4.0 SP4vagy fisabl seofver esetén)
jegyezze meg ](’)1 mert ennek ismeretében tud] a I személves kulcs torlése, ha a2 exportalas skertlt
>

telepiteni masik gépen tandsitvanyat.

< Vissza I Towabb = I Mégse

8. A kovetkez6 ablakban kivalaszthatjuk a fajlnevet,
és a helyet, ahol a fajlt 1étre szeretnénk hozni.

9. Miutan ezt beallitotta, mar csak a Tovabb (Next) és végil a Befejezés (Finish) gombot kell
megnyomnia, valamint a megnyitott ablakokat OK gombbal bezarnia.

A tanusitvany exportalasa ezzel megtortént.

Ezt az allomanyt érdemes biztonsagos helyen elzarni valamilyen adathordozén.
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